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Introduction to ChemProject

What it is

ChemProject is a program for the evaluation of a chemical synthesis in terms of material amounts and their costs,
featuring a highly intuitive graphical interface. A synthesis can consist of a main branch and up to 15 connected
branches. Data are analyzed for process efficiency according to a wide selection of criteria. Material prices may
conveniently  be imported from customizable and freely combinable price lists.  A variety of  detailed,  carefully
designed print reports is provided (the demo-version allows previews only).

System requirements

ChemProject was written using the “FoxPro for Macintosh” database program from Microsoft. However, since
ChemProject was compiled as a stand alone program, you don't need “FoxPro” to run it. The database language
is VERY slow on less powerful Macs. It is therefore strongly suggested to run ChemProject on 68040 based Macs
and PowerMacs. It  also runs on 68030 based Macs, but you will  need a lot of patience for calculations and
interface responses.

The minimum hardware requirements are:

• Mac LC III or higher (68040 processor or PowerMac recommended).
• System 7.01 or higher.
• 4.5 MB free RAM  (native PPC-version: 8 MB RAM;  4 MB when virtual memory or RAM Doubler are on). 
• 6 MB free hard disk space.
• 1640x480 pixel screen or larger.

Limitations

Since ChemProject has been written in a fourth generation database language, some direct programming control 
was not available and some compromises had to be taken in rare cases. E.g. double clicking a ChemProject file 
will launch the program, but not open the corresponding file. You will have to do this from within the program. 
Also, project files and price list files need to have DOS-like suffixes (".syn" and ".prc", respectively) to be 
recognized by the program. 

About this manual

This manual combines both a program reference, printed in plain black font, and a tutorial,  printed in italic dark
blue font  in a single continuous text. Beginners to ChemProject are guided through all relevant aspects of the
program by this combination of  information and tutorial.  More experienced users can selectively  consult  the
reference areas, occasionally utilizing the tutorial areas as an additional illustration. In all example pictures within
this manual the highlight color is pink. This color might vary from user to user according the individual setting in
the color control panel.
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Part 1

VIEWING THE PROJECT
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The Startup Screen

Launch ChemProject by double clicking its program icon: its main window appears. There are two options to
proceed from here:

• You can  open an existing project by clicking the project field (initially containing the word "untitled") once.
This will bring up a file dialog, from which the desired file can be selected. You can alternatively use the
Open command from the File menu.
=> see next page

• Or you can start entering a new project by filling in the data fields of the first step.
=> see page 11

• To start with, let’s open an existing project. Click inside the project field  (the one containing the word 
"untitled").  From the appearing file dialog, select the “tutorial” project located inside the ChemProject folder. 
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The Main Window (View)
The main window provides an overview over a branch of the current synthesis. Each step of the branch is divided
into  operations  (e.g.  reaction,  filtration,  crystallization...),  which  are  represented  in  a  pictographic  form.  This
cartoon-like sequence of operations allows a fast and selective access to operational data detail and an instant
assessment of the complexity of a step.

Operation  symbol : click
to reveal details (reagents,
prices, operating times.. .)
Project  (=synthesis)  name : click 
to open an existing project .
Branch : select the desired branch of the 
current synthesis.
Current page : if the current 
branch consists of more than 5 
steps, it is continued on additio-
nal pages. Select the desired 
page.

Step edit button : Opens a dialog  
for inserting an empty step or deleting 
the current one.

Quit : Leave the program. All changes to 
the project are saved automatically.
Print Reports : Opens a dialog offering 
a selection of print reports (source data, 
calculation results, analyses, materials 
lists)

Analysis : Opens a dialog containing 
a series of project analysis results 
(see page 9).

Price Lists : Opens a window for editing 
and maintaining material price lists.

•    Move to page two of the current branch (“Main”) using the “Page” pop up menu.
•    Move through the three branches of the “tutorial” project using the “Branch” pop up menu.
•    Then go back to the “Main” branch and click the first operation symbol of the first step: 
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The Source Data Window (View)
This window contains the original data of an operation. You may have entered these from your lab journal, a
publication or any other source. Each step is independent from another in its scale: one step may have been
entered in e.g. 120 g scale, while the following one is entered in 32 ton scale. Chemproject will automatically
adjust the scales of all steps during project calculation. Of course, all operations of a single step must be of the
same scale.

You can conveniently navigate through the whole project from this window without the need to switch back to the
main window.

Branch selector : 
Select the current 
synthesis branch.

Educt -> Product names : Copy of main 
screen name entries, no editing possible.
Operation selector 2 : Select 
one of the step’s operations directly. 
Operation symbol and time are up-
dated.

Operation selector 1 : Access 
the step’s operations sequentially 
using the arrow buttons. Operation 
symbol and time are updated.

Step selector : Select a step of the current 
branch. The yield is updated accordingly.
Attribute legend : see 
page 15 for a discussion of 
attributes.

Done : Closes this window and 
returns to the main window. The 
current project is saved au-
tomatically.

Edit region : See next 
chapter for data entry 
techniques.

Show Results : Opens the 
“project results” window (see 
next page).

Delete Operation : Deletes the 
current operation irreversibly.

• Click the “Show Results” button to view the material amounts required by the current operation to obtain a 
specified amount of synthesis final product.
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The Results Window
This window presents the results of a project calculation. By default, materials and costs are calculated for 1.000
kg of synthesis final product. However, you can enter any other amount into the “values calculated for” area. This
will instantly recalculate the project for the new amount. When the pop up menu is changed from “synthesis final
product” to “this step’s EDUCT”, the materials and prices are recalculated for the specified amount of the current
step’s starting material.  This highly  useful  when the scale of  a reaction you currently perform in your  lab is
changed (use the "Print Step" button to print the new step amounts).

Please  note  that  the  step  summary summarizes  ALL operations  of  the  current  step,  not  only  the  currently
displayed one. Obviously, the reagent cost and product value coincide for the first step of a branch.

Unit selector : defines the 
scale in which to display the ma-
terial amounts (kg/l, mg/ml, t/tl).

Navigation section :
same as in source data window (page 6).
Attribute bar : contains material 
attribute symbols (see page 15).
Edit Source Data : Go 
back to the source data 
window.

Step Summary : Reagent cost = step ma-
terial costs excluding step educt. Product 
value = cost of ALL materials used so far to 
obtain step product (accumulated value).

Operation volume : sum of material weights 
and volumes for apparatus size assessments. 
Only LARGEST exchange volume (blue entries 
- see page 15) is added to the sum.

ChemCost : sum of material costs and 
their percentage of total project cost.
Done : go back 
to main window.
Print Step : preview or 
print the current step.
Calculated  fo r: Interactive definition of what the current results are based on.

•  Click the DONE button to go back to the main screen. From there click the Print Reports button.
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The Reports Window

Select the type of print report, the amount of final product it is based on, and the destination (printer or preview)
from this dialog. 

Desired amount : Enter the 
amount of final product the report 
calculations are based on.

Report units : specify the units in 
which the materials are to be reported.
Preview Only : if checked, a preview of the report will appear (default 
for demo version). Otherwise the report will be sent to the printer.
Page Setup  : Specify details of 
your print document.
Report : specify the type of re-
port to print (see text below).

Original Source Data Original data entered from a lab journal or publication.
Calculation Full Fully detailed project calculation results.
Calculation Compact Project calculation results in compact form (less detail).
Materials by Project Summary of all project materials 
Materials by Branch Summary of all branch materials
Materials by Step Summary of all step materials
Project Analysis Results of project analyses (see page 9). Only the 10 most 

significant items of each category are reported. 

All reports except “Original Source Data” and “Project Analysis” are based on the indicated amount of synthesis
final product.

• Preview the different report types. Please note that you will be brought back to the main window after a 
completed report. Click the “Print Reports” button for accessing the next report).

• When done, remain in the MAIN window and press the “Analysis” button.
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The Project Analysis Window
This window provides you with essential information for the improvement of your project from the economic point
of view. Such analyses are particularly valuable to process research chemists. The window provides an online
description of each analysis type selected.

The analyses provide exact values for material amounts and costs, but relative data for operating costs, such as
the complexity of a step, the required volume or the required time. Such data are well suited for the comparison of
different projects without the need to know their actual operating costs. The higher the complexity, the larger the
volume and the longer the required time, the higher the operating costs of a project relative to another one. This
approach is in most cases sufficient to identify the project with the lowest prospective overall costs.

The left and right side of the project analysis window are identical in their functions. This enables side by side
comparisons: you could e.g. display a list containing the most expensive steps on the left side and check on the
right side for the most expensive material of each of these steps.

The analysis result lists start with the “worst” item on top, “improving” downwards. You can print these analyses
from the MAIN window by clicking the “Print Reports” button and selecting “Project Analyses” from the appearing
“Reports” window (see previous page). Only the 10 most significant items of each list are printed.

Analysis selection :
Select the type of analysis to 
be shown in the window below.

Analysis window : 
displays the analysis
results. 

Right window part :
Functions identical to  
functions on left side.

Analysis description :
Details the type of analysis chosen 
from the analysis selection pop up 
menu above.

Done : 
Go back to main window

• Click “DONE” to go back to the main window. - This concludes part one of the quick tour (viewing a project). 
The second part will deal about creating data and editing them.
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Part 2

CREATING & EDITING THE PROJECT
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The Main Window (Entering Step Data)

To create a NEW project, select New from the File menu. If no project is currently open, e.g. immediately after
launching the program, you can proceed without this menu command. The window should look as shown below.
Enter all data required by the first step, using either the ENTER, RETURN or RIGHT ARROW key to move to the
next entry. 

When all step data are complete (don’t forget to press e.g. RETURN after the last entry!), the “Operation” window
automatically opens for operation material input (see next page).

• Select New from the File menu, if your project is not already empty and untitled, as shown below:

• As an example of a new step, please enter the data as shown below. Use either the ENTER, RETURN or
RIGHT ARROW key to move to the next entry. Please note, that at this stage only the fields of the first step are
activated.

• When all step entries are complete (don’t forget to press e.g. ENTER after the last entry), ChemProject checks
their validity. If there is any validity problem, you will be prompted to correct it. Otherwise a new set of windows
opens, as shown on the next page.
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The Operation Window

ChemProject  divides  each  step  of  a  synthesis  into  separate  operations  for  better  overview,  structuring  and
analysis. A typical step might consist of a reaction, followed by an extraction, evaporation and crystallization. Two
operation types are distinguished:

• Operation & Reagents: operations, in which external materials are consumed. The first operation of a step
must  always  be  of  this  type.  The  currently  supported  types  are:  Reaction,  Extraction,  Crystallization,
Chromatography, Filter&Rinse, Suspension, App.Cleaning.

• Operation Only: operations, in which no external materials are consumed. They cause operating costs and
add to the complexity of a step. The currently supported types are: Evaporation, Distillation, Drying, Filtration.

As rule of thumb, whenever the product-(mixture) is transferred to another vessel or apparatus, a new operation
has to be defined. The first operation of a step is usually a reaction. 

Operation type : Specifies the type of
operations to be listed below (“operation &
reagents” or “operation only”).

Operation Symbol : 
Symbol of the currently 
selected operation.

Time : Enter the time required for the op-
eration. This entry is optional except for
“Reaction”.

Operations list : 
Select the desired op-
eration with a mouse 
click.

The "operation type" pop up menu is inactive when defining the  first  operation of a step, exclusively offering
"Operation & Reagents" type operations (as shown in the picture). 

As all operation times increase with the scale of the reaction, their time assignments should be redimensioned on
significant reaction scale up.

• Click on the different operation names in the operations list to view their symbols.

• Select “Reaction” as your first operation and type in an operation time of 2.5 hours. Press RETURN or click 
OK.
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The Source Data Window (Entering Data)

This window specifies all materials consumed in a specific operation, if of the “operation & materials” type.

The material price is either based on one kilogram or one liter of the material, depending on the unit specified in
the unit field. In case of a solid material unit like “mg”, “g”, “kg” or “t”, it is by definition based on one kilogram,
otherwise on one liter. If a solid material unit is changed to a liquid one, or vice versa, the corresponding price is
immediately recalculated according to the material density .

• In our example, after leaving the operation window, the screen below appears. The step educt, the reaction
name and the step product are copied from the corresponding main window data, along with the step yield, the
operation symbol and the operation time.

• Enter the example data below using the ENTER, RETURN or RIGHT ARROW key to move to the next field.
The step educt name is placed in a non-edit field, so the cursor jumps over it. After leaving a unit field, note the
appearance of the corresponding price unit (kg or l ) to the right of the “Price per...”  field. When the end of a
row is reached, the row below becomes activated.

Operation symbol : click here to 
edit the operation type and/or time.
Entry aids : uncheck boxes to deactivate the 
corresponding colums if not needed. Deacti-
vated fields will be skipped during data entry.

Operation materials table : this table lists all 
materials used in a specific operation. In case of an  
“operation only” process, this table is deactivated 
and empty.

Price units : “kg” if unit 
field contains a soild unit, 
otherwise “l”.
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Quick Find: High Speed Data Entry

Data input can be speeded up enormously by just entering the first character(s) of a material in the materials
field, followed by pressing CTRL-ENTER. This brings up the “Quick Find” window, which contains a selection of
materials starting with above character(s). This selection is based on all materials used so far within the current
project, as well as on all materials ldefined in the current  price list(s) (see page 26). After double clicking the
desired entry, all data is automatically entered into the corresponding material entry fields.

• In the fourth row, first enter the amount and unit as given below. In the materials field, just type a “T” or “t” (not
case sensitive). Your materials table should look like this:

• Now press the CTRL and the ENTER keys simultaneously (this command sequence is also indicated on top of
the materials column): the “Quick Find” window appears.

• Suppose you’d like to enter THF(purum). Double click the corresponding entry in the "Quick Find" window
which subsequently disappears to reveal the current material entry filled with all the required data.

• If you enter “TH” or “THF” instead of just “T” into the materials field, Quick Find accordingly narrows down its 
selection

.
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Assigning Material Attributes
Each material can have a specific property (an attribute): it may be recyclable, an exchange volume, or imported
from  another  branch  (see  definitions  below).  Use  the  materials  entry  button  to  access  such  definitions  in
the”Current Entry” window.

• In our example, let’s suppose we decided to recycle THF. Thus, click the THF-entry attribute button. In the 
appearing “Current Entry” window, click on the “Recycling (5x)” box . 

The “Current Entry” dialog offers options for different material attributes, as well as for inserting or deleting an
entry in the source data window. By default, materials contain no attributes. When materials are assigned an
attribute, their entry becomes marked accordingly in the source data window:

Attribute symbolsDefault  (grey background)
Recycling  (green background)
Exchange Volume  (blue background)
Exchange Vol & Recycling  (blue & green background)
Imported  (yellow background)

Exchange Volume (≈): Material which is added and successively removed during a single operation (mostly used
for extractions). Only the LARGEST of several exchange volumes is added to the total volume of an operation,
thus providing the MAXIMUM volume reached.

Recycling (®): Material which can be recycled. While its source price per unit remains the same, its calculated
chemcost (=> results window) is reduced by the recycling factor. A fixed overall recycling factor of 5 is assigned
(average  approximation). Please make sure that a recycling is actually feasible, especially when dealing with
solvent mixtures.

Import  (  «)  :  Material  which is imported from other branches of  the project.  This  attribute in fact  CONNECTS
different  branches  with  each  other.  The  pop  up  menu  offers  a  choice  of  branches  actually  available  for
connections, i.e. which are present and not already connected to other branches (page 25).

continued... 
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• Click OK. The attribute window disappears, the THF entry in the source window has obtained a light green
background, and its button symbol is “®” , which defines it as a recyclable material.

• Note that although THF is being recycled now, its source price per liter remains the same as before. This is
obvious, since the supplier price remains unaffected by your recycling. However, the material’s chemcost (=>
RESULTS window) is reduced by the recycling factor after project calculation:

• In order to check the effect of the recycling attribute, click the “Show Results” button. This brings up the 
RESULTS window, which shows the material requirements and costs of this operation calculated for 1 kg final 
product.

• Without recycling, 3.588 liters of THF would cost 3.588 x 34.00 = 121.99 currency. The indicated chemcost of
24.41 currency corresponds exactly to one fifth of this value (the recycling factor).

• Click the “Edit Source Data” button to switch back to the source data window.
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Adding A New Operation

When moving to the LAST operation of a step, the right arrow button symbol changes from “=>” to  “Add”. Click it
to append a new operation to the current step.

Click ADD to add a new operation

• Click the “Add” button.

• Select the “Extraction” entry from the appearing operation window, enter an operation time of “0.10” hours and
click the “OK” button.

After defining the operation type and time (the latter being optional except for “reactions”), the empty source data
window appears, ready for your input.

continued...
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• Enter the materials shown below. When you move to the price field after entering "Fluka 45770", the price is
filled in automatically, since above source specification was found in a price list. Please note that you may skip
source specifications and prices, like in the case of water in this example.

• Since we want this operation to describe the organic phase being washed with two portions of water, specify
both  water  entries  as  “exchange  volume”  by  clicking  their  respective  entry  buttons  and  assigning  the
corresponding attributes (see page 15).

• To see the effect  of  this  “Exchange Volume” definition,  click  the “Show Results”  button and examine the
operation volume field (below the material amounts). Only the LARGEST exchange volume is added to the
total volume. The “(max)” indication appears as an additional reminder. 

• Click the “Edit Source Data” button to return to the source data window.

• Click the “Add” button, which will bring up the operation window. This time select “Operation Only” from the
pop up menu and “Evaporation” from the list. Without entering an optional time, click “OK”.

continued...
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After the definition of an “Operation Only” type operation,  all  material  entries are in the source data window
become disabled and empty (see below). Although such an operation does not contain any material information, it
is causing operating costs and adding to the complexity of the step.

• Move back and forth between the three operations you just entered, using either the arrow buttons or the
operations pop up menu in the top right corner of the window.

• When finished, click “DONE” to go back to the main menu, where the three newly created operation symbols 
have appeared within the first step.
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Adding A New Step

After having entered the first step, the main window looks like this:

Now fill  in  the data fields of  the next  step.  After  entering the step yield,  the initially  disabled fields become
activated. When done, the operation window opens, followed by the source data window, as discussed on the
previous pages.

• Fill the four data fields of the second step with the data shown below.

• When all  fields  are  entered,  the  operation  window appears.  Define  the  operation  as  “Reaction”  and  the
operation time as 1.00 h. Click “OK”.

continued ...
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• Enter the data below in the source data window. Note that none of the materials are present in the supplied
price list, nor have they been used in this project so far. Therefore, the CTRL-ENTER sequence of QuickFind
(page 14) will not present any hits this case. Also note that this step is entered in kilogram-scale, while the
previous one was entered in gram-scale. This is perfectly fine, since ChemProject scales all steps to fit each
other on project calculation. 

• At this point, you would usually click the “Add” button to enter more operations. However, since this is just a
demonstration step, we will not add any more. Click “DONE”.

• The reaction symbol for the second step has appeared in the main window, which is ready for the entry of 
more steps.
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Saving The Project

Use the Save As... command from the File menu to save the current project. This menu item is only available
when the main window is the active window. It will bring up the file dialog:

• Select Save As... from the File menu.

If the current project has not been saved so far, the title “untitled.syn” appears as a suggestion. Change this name
to whatever you like. If you don't add the “.syn” appendix, it is automatically appended to the project name when
the file is saved. Files without this appendix cannot be recognized by the program. 

Note: Due to limitations of the programming environment, project file names are forced to lower case characters
after processing.

• Let’s call the example file “testfile.syn”. Enter this name in the name box, specify where you want to save it
and click the “Save” button. 

The new project name now appears in the “Project” field of the main screen (without the “.syn” appendix). 

You can also RENAME your project with the Save As... command.
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Creating, Deleting And Renaming A Branch

Create a new branch by selecting Add New Branch from the Project menu. Then enter the desired name in the
appearing branch dialog.

•    Select Add  New Branch from the Project menu. The branch dialog appears:

•    Enter “Branch1”. Of course, it could be given any other name.
• Click “OK”.

The main screen displays the name of the new branch in the branch pop up menu and is ready for the the new
branch data.

From the Project menu, two other branch operations are available. They both act on the currently 
selected branch:

•   Rename Current Branch: Brings up the branch dialog. Enter the new name and click “OK”.
•   Delete Current Branch: Deletes the current branch. Caution! All branch data will be lost.

continued ...

ChemProject - 25 - Table of Contents
_____________________________________________________________________________________________

 



• A very short step consisting of one single operation will be entered now for use in the next chapter. Please
enter the data given below.

• Specify the operation type as “reaction” and the time as “1.50” h in the operation window. Then click “OK”. 

• Since we don’t intend to enter any source descriptions or prices in this example, first uncheck the “Source”-
and  “Price  per...”  boxes  in  the  appearing  source  data  window:  the  cursor  now conveniently  skips  these
deactivated fields. 

• Enter the data above and click “DONE”. This provides the shortest possible branch, consisting of one single
step and operation. Of course, a branch will contain much more data in actual projects. The main window now
should look as below:
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Connecting Branches
A synthesis usually consists of a main branch, possibly connected to one or more side branches. These, in turn,
may be connected to yet other branches, thus building a synthesis tree. A connection between two branches
occurs, when one branch uses (imports) the final product of another one. ChemProject allows the simultaneous
use of up to 16 branches, which may be nested to any desired degree.

To define a material as being imported from another branch, click its material button in the source data window
(second picture below). This brings up the “Current Entry” dialog:

Check the “Imported from Branch” attribute. This entry is not accessible if no other branches exist within the
project, or if all are already connected. Specify in the the branch pop up menu, which branch this material is
imported from. For your convenience, only available (unconnected) branches appear in this menu. It is always the
final product of the specified branch, which is imported. After clicking “OK” the newly defined material appears
as a yellow entry in the source data window (see picture at bottom of page), with the “»” symbol on its button and
the source branch specified in the “Source” field.

• In our example, suppose we decided not to buy tosyl chloride, but to prepare it in a separate branch. We have
just created this branch on the previous page. Now we want to connect it to the “Main” branch.

• Since the connection can only be defined from the receiving branch, first move to the main window of the
“Main” branch, if not already there. Then click the reaction symbol of the second step. In the appearing source
data window, click the button of the “Tosylchloride” entry:

• Click the “Imported from Branch” box in the appearing window (see picture on top of this page). Since only one
branch (“Branch1”) is available, no other import choices are offered by the branch menu. Otherwise you would
have to specify the branch you want import from. Then click “OK” to complete the connection. 

• The newly connected branch will now be included in all project calculations. Look at different report previews
(see page 8) to verify this.
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Price Lists

Price lists are databases containing prices and densities of materials. Invisible to the user, they provide QuickFind
(page 14) with prices and other details of a requested material. The demo price list delivered with this program
(“Fluka-SFr”) is a very small one, containing prices and densities of a few common solvents. In practice, you will
have to build your own price lists, tailored to your needs, suppliers and local language & currency. Keep them at a
size of no more than a few hundred items for easy maintenance and optimum speed.

Only price lists located inside the “prices” folder and ending with ".prc" can be accessed. You could e.g. create a
price list  for small  order prices and one for bulk prices or different price lists for different suppliers for easy
maintenance. In any case, all price lists within the “prices” folder are internally merged to a single database when
ChemProject launches. If  you don’t  need specific price lists, move them outside this folder BEFORE starting
ChemProject. The “prices” folder can hold any number of price lists.

Current List : Select the existing price 
list to edit or view. Only lists located with-
in the “prices” folder are available.

Items  of the selected price list in alphabetical 
order. Click entries to access their details in 
the “Edit Current Entry” area.

Delete Current : Deletes the 
currently selected entry from 
the price list.

Add New Entry : All fields in the 
“Edit Current Entry” area become 
blank and ready for the entry of a 
new item.

Edit Current Entry : Enter or edit 
the detail fields of an item. Use the 
“Add To List” button to add a newly 
created item to the price list. Click 
“Done” when done with entering new 
items to reactivate items list.

Price Unit : Initially blank 
for a new entry. Select “l” 
or “kg”.

Create New List : Creates a new price list. Specify a name in the appearing name 
dialog. Then start entering the individual items in the “Edit Current Entry” area.
Print : Prints or previews 
the currently selected 
price list.

Use the RETURN key to move to the next field in the “Edit Current Entry” area. The material density entry is
required for solid/liquid recalculations. Also note, that the current list is automatically saved before printing it or
selecting another list.
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